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MARIE OSMOND ON THE STYLE AND SUBSTANCE OF SEWING

4 Marie Osmond’s love of sewing came from her mother and from working with some

of the best designers in the entertainment business. Find out what she’s sewing now

and try a fun kid’s project using cute designs from her Crafter’s Collections of lace

designs.

BEGUILING ARGYLE QUILT

7 The simple Square-in-a-Square patchwork pattern mimics the look of argyle in this

striking lap quilt.

ABOUT STYLE: “COWBOY CHIC”

10 Treat your sofa to some “cowboy chic” with this up-to-the-minute leather throw pil-

low embroidered with a delicate outline design stitched in a coordinating, variegat-

ed thread.

THE CRAFTER’S CHOICE 

12 See why stitchers who love to make craft items always turn to their BERNINA®

machines. 

DISCOVER YOUR CREATIVE JEANS

14 Deja-vu—the ‘70s are here again for jeans and denim duds! Plain is not good

enough so decorate your jeans with stitched trims, machine embroidery, and added

“glitz” to transform plain jeans into dazzling denims.

FLOWING BLOSSOMS JACKET

17 Add life to simple denim using multi-colored thread and free-motion stitching. Make

this trendy jacket to wear with almost anything, adding a subtle frayed trim along

the collar and front opening.

WINEGLASS COLLARS

20 Digitized using the BERNINA® Embroidery Software and stitched on stabilizer, these

wine glass collars are unique tags that help your friends and family identify their

wineglass all evening and can also double as place cards at the dinner table! 

SEW TO YOUR HEART’S CONTENT

21 Figure out your feet! Make a series of small quilts and heart shaped decorative

items using cotton scraps, wool felt, beads, buttons, and paint – along with several

BERNINA® specialty presser feet and accessories.

FELTED FLOWER VEST

26 This attractive wool vest has “back interest” created by a punched floral design,

further embellished with free-motion stitching and machine beading.

GRANDMA’S BRAG BOOK

28 The perfect size for Grandma’s purse, this little scrapbook photo album unfolds to

show loads of photos of your little angels!

STITCH RECIPE: LACY STITCHES

30 Stitch recipes are not just for sewing machine stitches! Try combining a beautiful

embroidery motif with some of your favorite machine stitches – the results can be

stunning! This recipe starts with a motif selected from Marie Osmond’s Expressive

Lace collection – “Lace Up Your Life” Vol. 1. Use it to embellish table linens, jacket

fronts, decorator pillows, and almost any type of sewing project.

SEW EASY ACCESSORIES

31 Brighten your wardrobe with these fashion accessories – “Sew Easy” to make using

commercial patterns and BERNINA® accessories and techniques.

SEW EASY FOR CHILDREN

34 It’s “Sew Easy” and so fun to create for kids! Make these great projects for the

children in your life using BERNINA® presser feet and quick techniques.
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BETH FERRIER

Beth is a highly experienced quilter with a gift for teaching. She was

given her first sewing kit in kindergarten and has been putting needle to

thread ever since. Find out about her seminars, books, and patterns at

www.applewoodfarmquilts.com.

KRISTIE SMITH

Kristie was introduced to sewing on BERNINA® machines in college

and loved it so much she took every sewing related class offered.

She’s been sewing on BERNINA® machines and teaching sewing

classes for 14 years. As a BERNINA® Educator, Kristie is extremely

passionate about sewing and loves to encourage others, especially

the younger generation, to create.

YVONNE PORCELLA

An artist specializing in wearables and art quilts, Yvonne began in

1962 by making unique garments, wall hangings and quilts. Her work is

currently featured in major exhibitions, art galleries and museums. She

is a vibrant expression of an artist who knows how to handle color with

an apparently endless palette. She hand paints fabrics to achieve a soft pastel

watercolor effect and uses a variety of these fabrics to create her art. Her work

features machine piecing in conjunction with appliqué and quilting and she feels

that cloth allows great versatility in expressing feelings and creative ideas. 

ELVA MUNGAI

A Resource Trainer for BERNINA® of America, Elva lives in Parrish,

Florida and for several years worked as a store manager for a local

dealer.

NINA McVEIGH

During 14 years of owning her own store, Nina developed and taught

her original patterns and designs in BERNINA® Clubs and Classes. An

avid quilter, heirloom sewer and lover of all kinds of embellishment,

she is also a collector of scissors, buttons and thread.

JILL DANKLEFSEN

Jill’s exquisite work with manipulating decorative stitches – playing

with them, changing them, creating texture with them – is one of

her specialties as a BERNINA® Educator.

BARBARA ALENCI

Barbara has been involved with sewing since she was 11 years old and

started making her own clothes. She opened a quilt shop in Florida 12

years ago, and a year later became a BERNINA® dealer. Since closing

her shop, she has been working for BERNINA®. Her favorite parts of the

job are teaching, and seeing the enthusiasm on the faces of her students.

FAITH REYNOLDS

As a BERNINA® Educator, Faith teaches national classes for both

dealers and consumers. One of her favorite topics is the use of the

BERNINA® Embroidery Software.

MARLIS BENNETT

As an Educator for BERNINA® of America, Inc., Marlis creates unique

interpretations of classic and heirloom garments, putting her own stamp

of creativity on machine-sewn projects.
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Webster describes craft as a “special skill or ability”. Stitchers definitely possess a special skill and

usually love to put those abilities to work by sewing a variety of projects. From quilts to garments to

home dec items, we all dabble in different types of sewing, learning useful techniques and expressing

our creativity in our own unique ways. When we think of sewing crafts, we usually think of small proj-

ects or items such as fabric boxes, bowls, vases, tote bags, book covers, and fiber art pieces. These

kinds of projects offer stitchers opportunities to experience all types of sewing techniques and can

give crafters creative satisfaction in a short amount of time.

This issue of Through The Needle features Marie Osmond and her Crafter’s

Collection of Expressive Lace embroidery designs. Marie started crafting at a

young age and feels that sewing and crafting with family and friends helps you

connect with others, similar to when our grandmothers held quilting bees. Her

beautiful lace designs can be projects in themselves such as the 3-D lace bow

shown here or can be incorporated into other projects such as the “Fun, Fanciful

Bookmarks” on Page 6. These are fast and easy to stitch and the kids in your

life will love helping!

For those of you that love to use your sewing and embroidery system for scrapbooking like I do, there’s

a fun, fold-up photo album on page 28. It’s called “Grandma’s Brag

Book” but can be adapted for any type of photos or small

mementos you want to keep with you.

To prove the old adage, “everything old is new

again”, we included an article on the “latest” craze,

embellished jeans. Some of us can remember this

from high school or college and we have a chance

to do it again! So, discover (or re-discover) your

creative jeans by trying some of the designs and

techniques on pages 14-16.

“Sew To Your

Heart’s” Content on

page 21 by Yvonne Porcella has several small heart-themed

projects that let you hone your craft by learning several tech-

niques using BERNINA® presser feet and accessories. Needle

punching, a relatively new craft in the world of machine tech-

niques, is a unique type of free-motion technique that almost

anyone can master in a short time. The “Felted Flower Vest”

on page 26 is a great beginner project with extra embellish-

ments (detail stitching and machine beading) that the experi-

enced sewer will love as well.

Bring your craft into the world of entertaining by creating and

embroidering “Wine Glass Collars” for your next party. These

unique tags, found on page 20, help your friends and family

identify their wineglass all evening and can also double as

place cards at the dinner table! 

So, no matter what type of stitch “craft” you like to pursue, this

issue of Through The Needle can inspire and encourage you

to develop your skills, perhaps learn some new ones, and keep

on creating!

from BERNINA®

GAYLE HILLERT
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Style
Part girl-next-door, part celebrity, and part modern-day mom, Marie Osmond
has plenty to keep her busy and fill her day. Even so, from a young age, she
has made time for sewing, needlework, doll collecting and designing. Marie
learned to sew from her mother, cutting pieces of leftover scraps and hand-
sewing them together for Barbie clothes. Her first real project was a pullover blouse and from there she gradu-
ated to making pajamas and Christmas stockings for her family. But it didn’t stop there. She says, “I took my first design class when I was
about 12 (right before Paper Roses came out) from George Trippon, a costume designer from Los Angeles. My Mom and I took Draping to learn

BY SUSAN BECK

“When in doubt, wear black. Brown is supposed to be the new
black, but I still like the real thing.”

“If you’re overweight, loose is better than tight. Don’t be afraid
to go up to the next size – it will look better than clothes that
are too tight. One of the best things you can do is take in the
underarm seam – start at the sleeve edge, stitching from noth-
ing, then widening out to about 1” where you bend your elbow,
and taper back to nothing at the armhole. For some reason, it
makes you look 10 lbs. thinner! You can also do this at the
side seams to get rid of the boxy look. If you are a new sewer,
lay it out flat, then use chalk and mark it on the jacket. I use
my serger to stitch it but you can stitch it on the sewing
machine, then zigzag the seams, and trim it if you want.”

“You can take what people think fashion is – for example, from
the runway – and whatever it is – a straight skirt, a long skirt,

a short jacket - it is your responsibility to make it look good on
you. You can modify anything through sewing and make it fit.
For instance you can take a suit and narrow the pant legs or
take out the shoulder pads to make it look current. There are
lots of ways to use your clothes over and over again without
buying new ones.”

“I’ve always heard, ‘Once you turn 40, it’s all about the acces-
sories!’ and my mother always said, ‘The greatest accessory
you can have is lipstick.’ But whether it is beautiful jewelry, a
purse, a great pair of shoes, or the detail on your clothing
such as embroidery and/or glitz,
accessories are important. This
embroidered flower from my new
embroidered lace collection can
be stitched as a three dimension-
al motif to make a brooch to
accessorize any outfit. Add glitz
and back it with decorative fibers
to give it your own touch!

Marie’s Sewing & Fashion Tips

“There’s nothing like seeing something you’ve made!”
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more about fabrics. I learned so much from George and other designers
about fabrics – that’s how I got into my dolls. I feel very passionate about
my dolls because they bring generations together – and so does sewing.”

As a working entertainer for most of her life, Marie has had the opportunity
to work with some of the top designers in the entertainment business includ-
ing Bob Mackie and Ret Turner. Famous for shows such as The Sonny and
Cher Show and The Carol Burnett Show, they also worked on the Donny and
Marie Shows, both the variety show in 1976 and the talk show in 1998.
Marie says she learned a great deal from professional designers. She says,
“The designer I consistently love – Ret Turner, who gave Bob Mackie his first
job, taught me more about fabrics and sewing than anyone. When you wear a
Bob Mackie, everyone knows it’s a Bob Mackie but when you wear a Ret
Turner dress, you’re who you are – you look fabulous as Marie Osmond.”

Like most stitchers, Marie has several projects in the works. She says, “Right
now, I’m felting a wool purse, putting in a cute lining, and adding glitz. And I like
to buy baby t-shirts and blankets and embroider little designs on them – so easy,
easy! My long-term project is making a king-sized quilt for each of my eight chil-
dren. I petit-pointed gigantic stockings for each of them while working on the
Sound of Music and the trick is – don’t do the baby last! Start with the oldest,
then do the youngest, and alternate back and forth.”

Full of ideas and always planning new projects, Marie says, “If it’s been done, it’s
been done, so let’s do something new!”

Substance
Hearing the enthusiasm in Marie’s voice as she talks about her projects, it’s obvi-
ous that she values sewing and creating. She sees the greatest benefit of sewing
as confidence. “There’s a clear sense of pride knowing you’re doing something
unique - I think through sewing you learn individuality.”

She also sees sewing as an activity for all generations. “I want to leave this life
knowing that what I’ve done will continue – from my work at the Children’s Miracle
network to passing down my dolls to my kids. Sewing is the same – when you
make a quilt to hand down or an heirloom for your children.”

“My mother was all about memories. When she was sick, I took my artista 200
and set it up next to hers. I realized you could embroider and quilt at the same
time! She couldn’t say much but everything she did say, I embroidered on a quilt. A
quilt is magnificent but to personalize it like that makes it incredible! After my mom
died, I made another quilt for my mother-in-law as a kind of therapy. I pieced it and
glitzed and it is beautiful! There’s nothing like seeing something you’ve made!”

“I think through sewing you learn individuality

“If it’s been done, it’s been done, so let’s do something new!”
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LADYBUG 
BOOKMARK
Select design 
#CC80925 – Flying 
Ladybug and/or 
Design #CC80926 – Ladybug

• Hoop the felt and tear-away stabilizer.

• Use the embroidery motif “as is” to embroider on the felt. Add a
second motif to your bookmark using the “add” or “duplicate” func-
tions of the machine. Note: With BERNINA® embroidery, don’t forget
that you have the options to move, rotate, and most importantly,
scale (change the size) your motif; the machine recalculates the
stitch count of your design so you’ll have beautiful embroidery at
any size!

• When stitching is complete, remove the felt from the hoop.

• Hoop the BadgeMaster stabilizer and repeat the embroidery process, creating “freestand-
ing” lace ladybugs or stars.

• When stitching is complete, tear away as much stabilizer as possi-
ble and remove the rest by rinsing and soaking in water. Let dry.

• Using Foot #20/20C and a bartack or zigzag stitch with the feed dog
lowered, stitch the lace ladybugs or stars to the ribbon as desired.

• Cut your felt to a bookmark shape of your choice. Cut a second
piece the same size. Place the ribbon piece(s) between the felt lay-
ers. Fuse everything together using fusible web.

• Add additional embellishment as desired with the EZ Glitzer and crystals.

“I love projects that I 
can do with my family. 
Here’s an easy one for 
kids using some of my 
lace designs. It’s a great 
‘together’ project – Mom 
and daughter, Mom and 
son, Scout troops, etc. 
And, it can be cool for 
gift giving – the kids 
can make these for 
their friends!”

GENERAL SUPPLIES
• BERNINA® Embroidery machine
• Expressive Lace, “Lace Up Your

Life” Vol. 1 design collection
• Felt pieces in desired colors

(large enough to fit the medium
embroidery hoop)

• 1/2 to 1 yard of narrow ribbon
• Isacord Embroidery threads in

selected colors (use same
thread top and bobbin)

• Organ Embroidery needle, size
70/10 or 80/12

• OESD Ultra Clean and Tear
stabilizer for embroidery on felt

• OESD BadgeMaster for free
standing lace pieces

• Open Embroidery Foot #20/20C
• Paper-backed fusible web
• BERNINA® IS-60 iron
• EZ Glitzer and crystals

Make useful and 
colorful bookmarks

to complement a
favorite book – or

try a holiday
design or favorite

motif.

To see all of Marie’s embroidered lace collections with stand-
alone and 3-D items, go to www.embroideryonline.com
• Studio BERNINA® Crafter’s Collection Embroider Your

Holidays – Christmas and embellishment items
• Studio BERNINA® Crafter’s Collection Home Expressions –

home embellishments and 3-D motifs
• Studio BERNINA® Crafter’s Collection Lace Up Your Life –

angels, ornaments, and fun motifs

STARS BOOKMARK
Select Design #CC80928 – 

Swirl Star



By Beth Ferrier

Finished size: 32" x 39"

The distinctive diamond-
shaped argyle pattern comes 
from the original hosiery 
worn with Scottish tartans. 
Cut from the same cloth as the 
kilt, but on the bias, the squares 
on the kilt became diamonds on 
the stocking. The simple Square-
in-a-Square patchwork pattern 
mimics the look of argyle in this 
striking lap quilt.

Quarter Inch Seams
Patchwork Foot #37 and Patchwork Foot with 
Guide #57 are identically designed except that 
Foot #57 has the added benefit of a fixed guide 
on the right side 
of the foot which 
aids in keeping the 
edges of the fabric 
under the foot 
ensuring perfect 
scant G" seams. 
Especially helpful 
for beginners, this 
guide also offers 
extra insurance to experienced piecers. Both feet 
make it easy to stitch a G" seam – the typical seam 
allowance used in traditional patchwork patterns. 
The side edges are exactly G" from the center 
needle position. The inner edges of the front of 
the toes are J" from the center needle position 
– a great asset 
when stitching 
miniature quilts, 
doll clothes, 
French seams, and 
other precision 
techniques.

Fabric Supply List
1 fat quarter (18" 
x 22") each of four 
fabrics (Colors 1-4)
I yard center square 
fabric
I yard sashing fabric
1G yards backing 
fabric

Notions and Other 
Supplies

Rotary cutter, ruler 
and mat

5" square of template 
plastic

Good quality 100% 
cotton thread, such 
as Metter Silk Finish 
50/3

Patchwork Foot #37 
OR Patchwork Foot 
with Guide #57

Straight stitch throat 
plate

•

•

•
•

•

•

•

•

•

Fabric Requirements
Center Fabric

Cut 3 strips 4I" x width of fabric, then 
cut into twenty 4I" squares 
Cut 4 strips 2" x width of fabric. Join 
end to end and press in half widthwise 
to make the binding.

Sashing Fabric
Cut 3 strips 6H" x width of fabric, then 
cut into forty-nine 2" x 6H" rectangles

Colors One & Four
Cut 2 strips 3M" x width of fabric, then 
cut into ten 3M" squares 
Cut 2 strips 2" x width of fabric, then 
cut into nine 2" squares
Cut 2 strips 1" x width of fabric (one of 
each color for the floating border)

Colors Two & Three
Cut 2 strips 3M" x width of fabric, then 
cut into ten 3M" squares
Cut 1 strip 2" x width of fabric, then 
cut into six 2" squares
Cut 2 strips 1" x width of fabric (one of 
each color for the floating border)

•

•

•

•

•

•

•

•

•

#37

#57
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Cut the triangles
Start with the 3M" Color 1 Fabric squares. Cut these on the diagonal 
once. Keep them stacked as neatly as you can in two stacks of five squares 
each.

Turn the stacks so that the long side of the triangle is at the bottom, the 
point at the top. Place the cheat on top of this stack so that line you just 
drew is right at the point of the fabric triangles. The bottom edge of the 
cheat should be even with the long side of 
the triangle.

See those points sticking out on either side 
of the cheat? Chop them off with your 
rotary cutter. Now the triangles will fit the 
center squares exactly! Repeat until you've 
chopped the points off of all the triangles 
cut from the 3M" squares. 

Sew the blocks
This little quilt is made 
of two color ways of 
the same block. They 
may not look very 
different, but to get the 
colors to play together 
in the end, the color 
placement is critical. Make ten each of Block One and Block Two. 

Start by sewing the odd number 
fabrics opposite from one another. 
Notice how perfectly they fit the 
center square! Be sure to keep Fabric 
1 on the left. Sew all twenty center 
squares this way. Always press the 
seams away from the center square. 

Next add the even numbered fabric 
and this is where you really need to 
pay attention to placement. On ten 
of the blocks, Fabric 2 goes clockwise 
next to Fabric 1 with Fabric 4 
opposite. On the remaining ten, Fabric 
4 goes clockwise next to Fabric 1 with 
Fabric 2 opposite. They really are 
different blocks!

Sashing Units
Sew a sashing strip to all 9 of the Color 4 
squares. Press the seams towards the square. 

Sew another sashing strip to the other end of 
six of the units you just made.

Make six double sash units with the Color 2 
squares.

 

Beth’s Sneaky  
Piecing Trick

The Square-in-a-Square is a simple block 
that can be a pain to make. Getting those 
silly triangles in just the right position 
against the center square can be a challenge. 
Here’s a simple solution.

Making a "Cheat"
The trick to getting the triangles to fit with 
the center square is to get rid of the “dog-
ears” by making a guide for removing the 
points. Cut the template plastic accurately 
to the same size as the center square; in 
this case it should measure 4I". Measure 
2K" from one edge and mark the vertical 
center of the template. You should also 
mark the template so you don't have to 
remember anything. This "cheat" is for a 
6" finished Square-in-a-Square block, the 
center square is 4I" and the triangles are 
cut from 3M" squares.

The secret to making this project easily and quickly 
is to keep the fabrics organized. Paste a scrap of each 
colored fabric in the appropriate triangle to create an 
easy reminder. 

8
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Sew the Four-block Units
Collect the blocks you've made, the sashing strips and the 
Color 3 squares.

This unit is made of two Block 
Ones and two Block Twos. It 
helps to lay them out to get the 
colors to line up. You'll rotate a 
Block One and Block Two to get 
all of Color 3 touching the square 
in the center. Make four of these 
units.

 The Half Units
With the remaining blocks, three 
sashing strips each and the Color 
3 squares, make two half-Unit 
blocks.

Put it All Together
Use the four-block Units, the half-units, the sashing units and 
the remaining Color One squares to put the quilt together as 
shown in the diagram. 

Layer and Quilt
Free-motion quilting is always my first choice. I use neutral 
trilobal polyester thread such as Pixelles™ Trilobal Polyester 
Machine Quilting Thread by Signature to quilt “swoopy” 
designs on my quilt. Use your favorite free-motion foot or try 
the new BERNINA® Stitch Regulator #42 (BSR) for even, 
consistent stitches every time (see below).

The Floating Border
A folded strip of fabric on each side next to the binding carries 
the color scheme to the edge of the quilt, adding continuity 
to the entire quilt. Press each of the 1" strips (one of each 
color) in half width-wise, wrong sides together, as you would for 
making binding. Machine-baste to the quilt top, matching raw 
edges and trimming to fit each edge.

Apply binding to the edges of the quilt using your favorite 
methods of binding. Tip: For an online class showing several 
binding methods, log on to www.berninausa.com > Online Classes 
> Sewing Classes > Binding Basics.

For more of Beth's projects and classes, go to 
www.applewoodfarmquilts.com

What used to take days of practice can now be mastered in a matter of minutes even 
if you’ve never free-motion stitched before. The BERNINA® Stitch Regulator #42 
is a free-motion presser foot attachment suitable for use on several BERNINA® 
Sewing Systems (aurora 430, aurora 440QE, artista 630, artista 640, artista 730, 
artista 200 with Upgrade Kit installed).

Freehand and free-motion techniques require the stitcher to move the fabric since 
the feed dog is lowered and cannot transport the fabric. As the fabric is moved under 
the foot’s optical sensor, the BERNINA® Stitch Regulator adjusts the speed of the 
machine and the movement of the needle to correspond with the movement of the 
fabric. A consistent stitch length is maintained resulting in beautiful stitches sewn in 
any pattern, any direction, and any design you want.

9
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Treat your sofa to
some “cowboy chic”

with this up-to-the-minute
leather throw pillow embroidered

with a delicate outline design stitched in
a coordinating, variegated thread.
INSTRUCTIONS
Set up the BERNINA® embroidery system and insert a new needle into the machine. Note: The
pillow shown was sewn with size 90 leather needle because of the thickness and weight of the
leather. See Leather Stitching Tips for more information. Thread the needle with variegated
thread and the bobbin with lightweight bobbin thread.

Hoop two layers of stabilizer; using a fabric marker, mark the center of the hoop. Lightly fold
the leather into quarters; unfold and mark the center with a piece of masking tape. 
Apply temporary spray adhesive to the stabilizer and adhere the center of the 17” square of
leather to the center of the stabilizer. Note: Do not hoop the leather as it may leave hoop
burns, damaging the surface. 

BY KRISTIE SMITH

SUPPLIES

• Desired embroidery design(s)
The design shown is from Studio
BERNINA® Quilting Fancy by Diane
Gaudynski #798 (available from
www.embroideryonline.com)

• One 17” square of leather for
pillow front

• Two 17” x 9” pieces of leather for
pillow back

• One 12” metal zipper
• One 12” pillow form  Tip: For a full

look, squeeze a 14” form into a 12”
finished pillow

• Walking Foot #50
• Non-stick Zipper Foot #54
• Size 80 or 90 Sharp or Leather

machine needle (see Leather
Stitching Tips for specifics)

• Isacord embroidery thread as desired
• OESD Heavyweight Cut-away stabilizer
• Polyester thread for construction
• HRFive temporary spray adhesive
• Rotary cutter with straight blade
• Rotary cutter with wavy blade 
• Rotary mat
• Nifty Notions® Cut for the CureTM Ruler

– 7” x 24”
• Variegated thread

For instructions to make this coordinating 4-patch pillow, visit
www.berninausa.com > Sewing Studio > Free Projects.

T H R O U G H  T H E  N E E D L E
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Select the desired
design; designs #24 and
#25 were used in the
sample shown in the
photograph. Edit the
design as needed (see
Leather Stitching Tips).
Stitch the design on the
leather pillow front and
trim the excess stabilizer.

Center the zipper down
one long edge of the
17” x 9” piece of
leather, right sides
together with the zipper
facing up. Stitch next to
the coils of the zipper
using Non-stick Zipper
Foot #54 and a far right

or far left needle position (depending on the side of the zipper you
are sewing). Tip: Foot #54 has a special coating on the sole to
enable it to slide over leather easily. Never place the non-stick
foot directly on the feed dog (without fabric between them) as the
coating on the foot may become scratched.

Open the seam and finger press. Using Walking Foot #50, top-
stitch the leather next to the zipper with variegated thread through
all layers. Tip: Use the FHS (Free Hand System) to raise the
presser foot and lower the feed dog at the same time, giving
extra room that makes it simple to slide several layers of leather
under the presser foot. 

Repeat the previous two steps with the remaining back piece and
the other side of the zipper.

Select a zigzag or decorative stitch and topstitch the remaining
seam closed beyond the zipper ends. Tip: Practice decorative
stitches on scrap leather before stitching on project.

Layer both pieces of leather (pillow front and back), wrong sides
together. Trim both to 16” square using a ruler and straight edge
rotary cutter. Note: Do not pin into leather as this will leave holes!

Using Walking Foot #50, stitch
around all edges of the pillow,
2” in from the edge, using a
stitch length of 4mm-5mm.
Tip: Set the sliding seam
guide on the Slide-on sewing
table 2” from the needle.
Align the edges of the pillow
with the guide as you sew.

Trim the outer edges of the pillow using a wavy cutter and ruler.
Insert the pillow form through the zippered opening in the back,
close the zipper, and enjoy your fabulous pillow!

Leather Stitching Tips
Stitching on leather is simple to do but requires a few adjust-
ments for the best results. Consider these points when select-
ing your supplies and planning your project; always sew at
least a partial design on scrap leather before stitching on your
project.

LEATHER
• Look for leather thick enough that it won’t distort, but not

so thick that the needle has trouble penetrating it. 
• Some common types of leather are:

- Lambsuede—weighs 1.5 oz./square foot—thin and soft
- Cowhide and cowhide split—weighs 1.5-4 oz./square
foot—medium weight

- Cowhide plongé—weighs 1.75 oz./square foot—soft,
supple feel of lambskin, but more durable

DESIGNS
• Look for light, airy designs; stay away from dense designs

to avoid a high number of needle penetrations that can per-
forate the leather, especially light, soft types. 

• Designs can be edited (using BERNINA® Embroidery
Software) to decrease the stitch density. Note: Designs can
also be edited on-screen when using artista models 200E
or 730E using the Stitch Properties function.

• Suede tolerates dense designs better than leather; stitch a
test to see what works with your leather.

• Short stitch lengths can also perforate the leather; edit the
design to increase stitch length.

• “Outline only” designs (such as continuous line quilting
designs) with a medium to long stitch length work well for
stitching on leather

STABILIZERS
• Soft, thin leather, can use fusible or soft cut-away stabilizers
• Medium to heavyweight leather that is hard works best with

tear-away stabilizer
• Medium to heavyweight soft leather, use cut-away stabilizer

NEEDLE
• Select a sharp needle for soft, pliable leathers
• Use a leather needle on heavy, thick leathers only
• Use the smallest size needle point possible—usually an   

80 or 90 
• For soft, stretchy leather, use a ballpoint if there is a prob-

lem with thread breakage

EMBROIDERY THREAD
• Use a 40 wt. Polyester thread such as Isacord embroidery

thread for decorative stitch work.
• 30 wt. with a size 90 needle may provide better coverage

with a design that has decreased density and stitch length 

OTHER
• Decrease motor speed
• Decrease upper thread tension if needed to reduce thread

breakage
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The only way to build your skills and
develop your craft in any area is to

play and practice – using quality equip-
ment. That’s why so many crafters

who work in needle and thread choose
the dependability, the sturdiness, and
the innovation of BERNINA® sewing
and embroidery systems. These are
some of the features, functions, and

accessories that crafters turn to 
over and over to create, stitch and
embellish their favorite projects.

EASY TO USE
Simple stitch selection by push button or
touch screen and easy-to-change settings let
you spend your time sewing rather than adjust-
ing your machine. And, almost every BERNINA®

sewing machine offers Altered Stitch Memory
that lets the machine remember changes to
your stitch settings until the power is turned
off, even if you move from stitch to stitch to
stitch. No more remembering and resetting
every time you reselect a stitch – especially
useful when alternating between several deco-
rative stitches on one project.

PRECISION STITCHING
From sturdy seams to decorative stitching,
the integrity of the stitching is important
when crafting high-quality gifts and personal
items. BERNINA® machines offer a precision
stitch that has no rival. There’s no coasting
when the foot pedal is released – the stitch-
ing ends exactly where you want! The exclu-
sive electronic foot control lets you stitch
one stitch at a time – or even half-stitch by
half-stitch – for perfect control when stitching
techniques require precise stitch placement. 

CONSISTENT TENSION
Consistent tension for both straight and dec-
orative stitching lets you start sewing imme-
diately – on all types of fabric, from velvet to
denim – without “fiddling around” or making
stitch adjustments.

FREE HAND SYSTEM
Lift the presser foot and lower the feed dog using the knee-activated lifter for the
most clearance space between the presser foot and the stitch plate - perfect for proj-
ects with multiple, thick layers. Works as a “third hand” to help you control the fabric
under the needle and speeds sewing time by 20% so you can produce more stitched
masterpieces in less time. The FHS lets your hands stay focused on creating instead
of being interrupted by simple manual tasks such as raising the presser foot.

HEAVY DUTY DC MOTOR
Provides powerful needle penetration for multiple layers with no hesitation or
false starts. No need to avoid thick fabric, heavy trims, multiple layers of card-
stock, or sewing through hook-and-loop tape. 

PRESSER FOOT PRESSURE ADJUSTMENT
Offers the option of adjusting the pressure of the presser foot so that all types
of projects – from furry teddy bears to dainty doll dresses – can be easily
stitched. Can also be adjusted to make the presser foot glide easily over seams
and uneven layers.

LARGE SELECTION OF PRESSER FEET
BERNINA® has a wide range of specialty presser feet designed to make tech-
niques such as gathering and hemming faster and easier. Finding the right one
for the job makes sewing faster and easier with a minimum of frustration.
• JEANS FOOT #8 – When sewing through heavy fabrics or multiple layers, this

hinged, straight stitch only foot is specially designed to keep the needle from
being deflected through thick layers of fabric as well as focusing the penetration
power of the needle so that the foot moves easily over varying thicknesses.

• BUTTON SEW-ON FOOT #18 – Great for adding decorative buttons as embell-
ishments and for tacking/tying layers of fabric together. 

• BRAIDING FOOT #21/12C – Both of these feet work well for couching decora-
tive cords and yarns to add texture and pattern to any type of project.

• CLEAR FOOT #34/34C – The clear sole of this foot allows great visibility of
the stitching area. This is especially helpful when scrapbooking with your
sewing machine as there is no room for error when stitching on paper. The red
markings are also useful as guidelines to help position your stitching exactly
as you need it.

• PIPING FOOT #38 – This foot is great for situations where the sewing surface
is uneven such as when stitching hook-and-loop tape or attaching webbing.

• CLEAR EMBROIDERY FOOT #39 – Perfect for satin stitch appliqué because
the sole of the foot has a wide indentation on the bottom to enable it to pass
smoothly over heavy stitching; and the sole is clear so you can easily see the
edge of the appliqué to position the stitch exactly as needed.

• BERNINA® STITCH REGULATOR FOOT #42 – Stitch any pattern, any design, any
direction with this free-motion foot that regulates the stitch length for you. You

Fabric by Benartex: Triple-Dyed Bali Batiks Tutti-Fruitti



can master free-motion techniques in min-
utes, without practicing for weeks! Note:
Available only on selected BERNINA® models.

• ROLLER FOOT #51 – Literally rolls over
“sticky” materials such as plastic, vinyls,
and leather and is great on textured,
“loopy” fabrics as the rollers won’t catch
on the loops.

• NON-STICK FEET #52-54 – Zigzag,
Straight, and Zipper feet with specially
coated soles so they glide over “sticky”
materials such as plastic, vinyls, and
leather.

• WALKING FOOT #50 – Makes quick work
of handling pile, slippery, or plaid fabrics
by feeding the top and bottom layers of
fabric simultaneously. Great for not only
straight stitching, but also for decorative
stitches.

• CIRCULAR EMBROIDERY ATTACHMENT
#83 – Sew any stitch and almost any tech-
nique in a circle! From pintucks to binding,
this attachment works with any presser foot
and most of the sewing machine stitches
programmed into your BERNINA® machine.

• BINDER ATTACHMENT #84 WITH BINDER
FOOT #94 – Excellent for speed finishing
and construction techniques for items
such as baby bibs, tote bags, doll clothes,
and more. Gives your creations the per-
fect finished edge!

• NEEDLE PUNCH ACCESSORY SET –
Felting attachment for certain BERNINA®

models that lets you mesh fibers such as
yarn or wool roving into a base fabric such
as wool or felt.

CREATIVE FUNCTIONS
A large assortment of practical and decora-
tive stitches, along with machine functions
offer a number of techniques for craft sewing.  
• MEMORY - Combine your favorite stitches

to create great borders.
• LETTERING - Program lettering into the

Memory function to add the perfect saying or
verse to a special creation.

• PATTERN BEGIN/END – Start a pattern
precisely where you want and know exactly
where it ends.

• MIRROR IMAGE – On selected models,
you can mirror your stitch (Up/Down
and/or Right/Left) to get the look and the
placement exactly as you want.

ADJUSTABLE NEEDLE POSITIONS
Place stitching exactly where you want on any type of project. The ability to
adjust the needle position with any stitch is a BERNINA® exclusive and gives you
maximum versatility for all types of craft projects.

NEEDLE STOP UP/DOWN OPTIONS
• ELECTRONIC FOOT CONTROL – This exclusive feature gives you complete

control over the movement of the needle and lets you work with one or even a
half stitch at a time without removing your hands from the fabric, so both
hands are free to maneuver your project as needed. 

• NEEDLE STOP UP/DOWN FUNCTION – Just “tell” your machine to stop with
the needle up or down by engaging the function – and it does! 

FREE ARM OPTIONS 
The narrow sturdy freearm of the machine is for sewing tubular items such as
stuffed animal parts, purses, and doll clothes. The slide-on table becomes a large
freearm that gives easy access for stitching tote bags, hatbands, and any hard-to-
access areas that need more support than provided by the machine free arm.

BEAUTIFUL EMBROIDERY
Rescale designs to almost any size so you don’t have to plan your projects around
any machine or design limitations. Whether stitching on cardstock, velvet, cotton,
or denim, you can control the stitch density and the size of the design. Versatile
lettering options let you personalize any project. 

LIFETIME INVESTMENT
Crafting gifts and practical items for those special people in your life has it’s
own rewards and a BERNINA® investment will pay off for years to come. Known
for their quality, long and useful lives, and excellent resale value, BERNINA®

machines will help you 
become a master 
craftsperson.
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Samples by Jill Danklefsen, 
Marlis Bennett, and 

Madeleine Fuellemann
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General Directions
Preparing The Jeans  
(before decorating)
Using a seam ripper, remove 
the stitching of one inside leg 
seam, opening it about 18”. 
The stitching may be sewn on 
the outer leg of the jeans, over 
the side seam or on the front 
of the leg. Also, remove one or 
both back pockets if desired.

Embroidering The Jeans
To stitch embroidery designs on your jeans, spray Poly Mesh stabilizer 
with temporary spray adhesive and adhere to the back of the jeans. 
Place the plastic template (included with hoop) on top of the jeans, 
aligning the center with the 
desired location of the design. 
Lift jeans and template and 
place into hoop, keeping the 
seam line aligned with the 
vertical center of the hoop. 
Tighten hoop and begin 
embroidery process using 
Isacord embroidery thread 
and a size 90 Organ Titanium 
embroidery needle.

Completing The Jeans (after decorating)
Once the embellishing is complete, finish by re-sewing the inseam and 
re-stitching the lower hem using the techniques below.

8mm Lap Seam Foot #71
For a lapped seam about ¼” wide, pin wrong sides together; bottom 
layer should extend about ½” beyond the top layer. Fold the lower 
piece over the top piece and slide it under the presser foot; the fold 
should align with the inner right toe of the foot. Sew four stitches, then 
use the FHS to raise the foot and guide the fabric into the slot, over the 
left toe of the foot and then continue to stitch. Press the seam toward 
the raw edge. Slide the seam under the presser foot so the first stitching 
is visible in the slot. Sew four stitches, guiding the fabric into the slot 
over the left toe. Sew the remaining line of stitching.

Jeans Foot #8
The hinged sole of this foot 
allows it to glide over varying 
thicknesses of fabric. Use with 
a Jeans needles and a Straight 
Stitch Plate to achieve the 
most penetrating power. Jeans 
needles, available in sizes 70-
110, have sharp points and are 
designed for use with dense 
denim fabrics. Note: This foot 
requires a size 100 or 110 needle 
to perform properly.

Deja-vu—the ‘70s are  

here again for jeans  

and denim duds! 

Plain is not good enough so decorate your jeans to express yourself. Stitched trim, machine 
embroidery, and added “glitz” come together to dress the denims shown here. So step back in 

time, plan your design and transform plain jeans into dazzling denims.
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Tuxedo Jeans
by Marlis Bennett

Supplies
21⁄2 yds of 5⁄8” ribbon

1 spool YLI Pearl Crown Rayon

Size 90 Jeans needle

Aqua Mesh Stabilizer

HRFive temporary spray adhesive

Mega-Hoop

Large oval hoop

Edgestitch Foot #10/10C

Secondary bobbin case

BERNINA® Embroidery Software

DigiBobbE Collection 2 Woodland Swirls

In the Hoop™ Hoop it Wrong Stitch it 
Right

60wt Mettler cotton embroidery thread 
in color to match YLI Pearl Crown Rayon

Screw driver

Ribbon
•	 Pin the ribbon to the pocket, 

mitering the corner.

•	 Sew ribbon in place using 
Edgestitch Foot #10/10C  and 
matching thread. Select a 
Zigzag stitch with a SW of 
2.0mm and SL of 1.5mm. Keep 
the pocket open during the 
process; most jean pockets 
will fit on the free arm of the 
sewing machine. Remove the 
pocket from the free arm. 

•	 Stitch along each edge of the ribbon down the length of each leg, 
folding the ribbon under at the hem.

Embroidery - Pocket
•	 Wind bobbin with YLI Pearl Crown Rayon; insert into secondary 

bobbin case.

•	 Adjust bobbin case tension with a screwdriver so that the thread 
flows easily through tension. 

•	 Hoop Aqua Mesh stabilizer in large oval hoop; spray stabilizer with 
temporary spray adhesive.

•	 Place jeans pocket area into hoop, right side down; pin pocket bag 
away from area to be embroidered.

•	 Open motif #213.art in embroidery software. Print templates (one 
for each pocket). 

•	 Trim around template with scissors.

•	 Place template in area to be stitched. Use In the Hoop™ angle finder 
to find desired angle to stitch design.  

•	 Send design to machine via your desired method of motif transfer.

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•	 Rotate motif if necessary.

•	 Turn handwheel to bring 
bobbin thread up through 
jeans.

•	 Embroider pocket area. 

•	 Bring bobbin thread to wrong 
side at end of stitching and tie 
off.

•	 Repeat for second pocket.

Embroidery - Leg
•	 Combine motifs #202.art, 209.art 

and 214.art as pictured. 

•	 If digitizing software is available, 
digitize a straight line to help 
with aligning the combined 
motifs along edge of ribbon.

•	 Digitize straight line on right 
side of motif combination.

•	 Use arrange/color film to move 
the line to the first position.

•	 Send combined motifs to 
machine.

•	 Repeat hooping and 
embroidery process for each 
leg. Mirror motif for second leg.

Full of Grace
by Jeanne Delpit

Supplies
Studio BERNINA® Gothic Grace 
by Kaye England (available as an 
Embroidery Take Out Collection from 
your local BERNINA® dealer)

BERNINA® Embroidery Software  
– any level

Isacord embroidery thread

OESD PolyMesh stabilizer

HRFive temporary spray adhesive

Large Oval Hoop (Mega-Hoop will 
require fewer hoopings)

Instructions
•	 Open the BERNINA® Embroidery Software and import the desired 

designs, rotating, skewing, and combining them as desired. Note: 
The designs on the sample were positioned with the side leg seam as a 
base point, placing as little stitching in the thickness of the jeans seam 
as possible. The main intention was to have the widest part of the 
complete embroidery design at the bottom of the jeans leg, forming a 
triangular over-all shape up to the knee.

•	 Stabilize and hoop the jeans (see the section on preparing them at 
the beginning of this article).

•	 Stitch the complete design, re-hooping as needed.

•

•

•

•

•

•
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Swirls of Black 
by Debbi Lashbrook

Supplies
Designs from OESD: Tribal 6, Pack 
#11926 (www.embroideryonline.
com)

BERNINA® Embroidery Software 
– any level

Mega-Hoop and Template

Isacord embroidery thread

OESD Stabil-Stick stabilizer

HRFive temporary spray adhesive

Instructions
•	 Open the BERNINA® Embroidery 

Software and open design NZ953 
(purple design). While selected, group. 

•	 Right-click on Rotate 45 deg CCW / CW two times; move the  
design into place along upper right side of jeans.

•	 Select File/Insert Design to add #NZ947 (aqua); group.

•	 Left-click on Rotate 45 deg CCW / CW one time.

•	 Open Object Properties while design 947 is still selected. Change 
the height to 98mm. Click on OK.

•

•

•

•

•

•

•	 Select File/Insert Design to add  #NZ949 (mauve); group. 

•	 Mirror Vertical, then left-click on the Rotate icon one time. Move 
into place at bottom of jeans.

•	 Select File/Insert Design #NZ948 (turquoise).; group. 

•	 Copy and Paste Design #NZ948. 

•	 Right-click on Rotate 45 deg CCW / CW one time and move into 
place at the top of 
the design area.

•	 Select the copy 
of the design and 
Mirror Vertical. While 
it is still selected,  
left-click on Rotate 
45 deg CCW / CW 
one time and move 
into place toward the 
bottom of the jeans. 

•	 Stabilize and hoop 
the jeans (see 
the section on 
preparing them at 
the beginning of this 
article).

•	 Stitch the complete 
design, re-hooping 
as needed.

Butterfly Garden 

by Gayle Hillert

Don't stop with embroidery. Use decorative stitches, added jewels, and related 
trinkets and charms to complement the look of your decorative theme jeans. To 
complete the overall design, add stitches and designs to the back pocket and 
elements of the design near one of the front pockets.
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Add life to simple denim using multi-colored 
thread and free-motion stitching. Make 
this trendy jacket to wear with almost 
anything, adding a subtle frayed trim 
along the collar and front opening.

INSTRUCTIONS

1. Preshrink denim fabric.

2. Cut out pattern pieces in desired size.

3. Trace right front pattern piece onto the pattern tracing material.

4. If the pattern has a built-in front facing, cut it off on the fold line and add a
5/8” seam allowance to both the front piece and the facing piece.

5. Lay out all pattern pieces on the fabric and cut rectangles of fabric that are
at least 1” larger than the pattern piece on all sides.

6. Insert a Size 90/14 Jeans needle and thread with Jeans Stitch thread.

7. Wind bobbin of Mettler 50/3 Silk Finish cotton thread.

8. Do a test-sew and adjust tension as needed.

9. Attach the BERNINA® Stitch Regulator Foot #42 and set up the machine as
per manual. 

BY BARBARA ALENCI

SUPPLIES
• Simple, unlined jacket with no collar - Vogue #7947 was used in the

sample shown
• Denim yardage according to the pattern envelope
• YLI Jeans Stitch thread (Traditional Variegated – 03V-VA)
• Jeans Needle Size 90/14
• Mettler 50/3 Silk Finish Cotton thread in color to match denim fabric 
• BERNINA® Stitch Regulator Foot #42 (BSR)
• BERNINA® machine that supports the BERNINA® Stitch Regulator

feature; either an artista 730/640/630; an aurora 430/440QE;
or an upgraded artista 200 Note: For other machines, select your
favorite free-motion foot

• Pattern tracing material 
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10. No need to mark
design on fabric. Sew
about a 1/2” circle
and then begin
sewing petals until
the entire circle has
petals attached. 

To proceed to the next
flower, simply sew some
“squiggles” as you move
on to another flower.

11. Continue until the
entire piece of fabric
is covered with free-
motion stitched flow-
ers. Note: Facings do
not need to be
embellished.

12. Lay pattern pieces
out on embellished
fabric; cut. 

13. Cut a 1” wide strip of fabric the length of the collar piece. Cut another strip
1” wide by the length of the right front piece. Make sure that these strips
are cut on the true grain of the fabric. Note: If the trim is cut on the crosswise
grain, the fringe will be white; if cut on the lengthwise grain it will be blue.

14. Construct the jacket using the pattern instructions with the following exceptions: 
COLLAR: Insert the 1” strip of denim into the seam when sewing the two pieces
of the collar together. Trim and turn right sides out; fray the strip of fabric.
RIGHT FRONT: Insert the remaining 1” denim strip between the right front
and the right front facing before sewing. Sew together with a 5/8” seam.
Trim and turn right sides out; fray the strip.

15. When jacket is complete, wash and tumble dry to enhance the look of the
frayed trim.
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Getting ready to entertain?
Make these wine glass collars
for your next party, creating
a personalized keepsake for
each guest. These unique tags
help your friends and family
identify their wineglass all
evening and can also double as
place cards at the dinner
table! Digitized using the BERNI-
NA® Embroidery software and
stitched on stabilizer, these
wine glass collars are fast to
make and can easily be dispos-
able items if desired.

SUPPLIES:

• BERNINA® Embroidery software – Designer
Plus level

• Isacord Embroidery threads 

• OESD HeavyWeight Cut-Away stabilizer

Open Designer Plus software. Note: Hoop display and
Grid display are optional; select if desired.

CREATING A TEMPLATE
Select Circle/Oval Tool; Select Single for Outline.
Digitize a circle with a diameter of ~3 inches or
90mm.

Select different color and digitize a smaller circle with a
diameter of ~ 3/4” or 20mm. Select both circles by hold-
ing down the Ctrl Key as you select each circle. 

Select Align Centers tool, which will automatically
center the circle motifs.

Save this newly created motif as Wine glass
template.ART

DIGITIZING A BASIC COLLAR

Select Fill tool > Step; select the Closed
Curve tool.

Trace the template with a series of left and right
mouse clicks, starting in the middle, where the
opening will be for the wine glass. When complete,
touch the Enter key.

Create a new file to complete the collar so you
won’t digitize over the template file; Select the
newly created fill shape. Select Edit > Cut; File >
New; Edit > Paste.

Create a border edge to “hold” everything together.
Simply use the Duplicate command; Edit > Duplicate.

Select the duplicate copy and change the fill to a single
outline; also change the color: Select Outline > Single;
Select Color > different color.

With the Fill selected, experiment with using the Craft
stitches for fills with an open look.

Select Lace Fill.

Select Blackwork fill.

Select Open curve tool; Select Outline > Satin.

Use the Open Curve digitizing tool and create a
Satin Stitch border: Select

Outline > Pattern Run. To make the
collars more interesting, add a
Pattern Run border around the outer
edge of the satin stitched border.

CUSTOMIZING THE COLLAR 
To add names or initials to the collar, select the
Lettering / Values tool. Type in the desired letters.
Select the desired Font and Baseline style.

When working with curved baselines, the
Reshape Object tool can be used to give the prop-

er visual spacing of lettering if needed. Adjust as desired. 

Adjust the colors of the digitized wine glass collar as
desired. When satisfied, save the file and send to the
embroidery machine of your choice. 

STITCHING THE COLLAR
To stitch, hoop one layer of OESD HeavyWeight Cut-Away
stabilizer. When stitching is complete, simply trim the
excess stabilizer from around the outer edges and the
inner circle of the collar. Note:  Combine and stitch more
than one collar per hooping by using the machine’s on-
screen editing capability.

BY JILL DANKLEFSEN

To download this project:
www.berninausa.com >

What’s New > 
Free Downloads > 

Free Bernina Project
Embroidery Designs >

Wineglass Collars



This collection of presser feet is 
useful when making the heart 

projects shown here.  
For additional information, see  

Feet-ures, Volumes 1-3, available at 
your local BERNINA® dealer.

These “feel good" sewing 
projects give you opportunities to 

try a variety of specialty presser feet 
that make stitching easier and the results 

better. Make a series of small quilts and heart 
shaped decorative items using cotton scraps, wool 

felt, silk pieces, beads, buttons, and paint - along with several 
BERNINA® specialty presser feet and accessories.

Zipper Foot #4 Edgestitch Foot 
#10/10C

Button Sew-On Foot #18

Open Embroidery Foot 
#20/20C 

Braiding Foot #21 OR 
Bulky Overlock Foot #12C

Clear Foot #34/34C Quilting Seam Guide

Figure Out 
Your Feet! 
By Yvonne Porcella
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Confetti Heart  
Mini Quilt

Supplies: 
Heart Pattern #1
Three pieces cotton fabric, 8" x 8" for quilt block,  
contrast, & backing
assorted scraps for confetti
Wonder Under (paper-backed fusible web)
8" x 8" square of batting
fabric paint, brush & stencil

Step One
Open Embroidery Foot #20/20C; Running Stitch - Width 
5mm-6mm, Length 0.5mm to 1mm
Lay the contrast fabric on your cutting mat; cut pieces of 5 to 
6 different fabrics into small irregular snips and layer randomly 
or in color groupings to cover most of the square. Fill in blank 
spaces so little of the contrast fabric shows. Hint: Use tempo-
rary spray adhesive to hold the snips in place if desired. Carefully 
take this to sewing machine. Tip: Use a Slide-on Sewing Table or 
Extended Sewing Table to support the fabric so the square is not 
allowed to hang over the edge of machine. Use a bamboo stick 
to hold snips in place as you sew with a Running stitch and 
matching thread color. Stitch completely to secure each little 
snip. When you think you are finished, add decorative thread 
and stitch again to secure fabrics to the surface.  

•
•

•
•
•
•

Step Two 
Fuse Wonder Under to the back of stitched panel for 3 to 5 
seconds with dry iron. Trace heart Pattern #1 on the paper side. 
Cut out the heart and remove the paper. Fuse the heart to the 
center of the quilt block square, pressing with steam for 10 
seconds. Tip: To find the center of the fabric square, fold in half 
vertically and horizontally, finger pressing creases in place. The 
intersection of the creases is the center of the block. 

Step Three
Edgestitch Foot #10/10C; Blind Stitch - Width 3.5mm, 
Length 2.5mm  
Layer the block right side up over the batting and the backing 
(right side down). Pin the edges. Using the Blindstitch, stitch 
around the edge of the heart, keeping the blade of the foot 
next to the edge of the heart. Note: The straight portion of the 
stitch will sew along the outside of the heart appliqué and the 
wide part of the stitch will “bite" into it. 

Step Four
Clear Foot #34/34C; Straight Stitch - Width 0mm, 
Length 2.5mm 
Select the straight stitch with a length of 2.5mm; fill in 
background with random diagonal stitching lines to 
edges. Press; square up the block. Cut two binding 
strips, 1¾" x 8" each. Stitch one strip to each side 
edge using a ¼" seam allowance. Press out, fold 
under raw edge, press again.

Step Five
Edgestitch Foot #10/10C; Straight Stitch - Width 0mm, 
Length 2.5mm 
Stitch-in-the-ditch from the right side of the quilt to secure 
the binding. Cut two additional binding strips, 1¾" x 8" each, 
sew to the top and bottom edges, then stitch-in-the-ditch as 
before. Option: Use the Binder Attachment #84 with Foot #94 to 
bind the edges of this mini quilt.

Step Six
Using the tip of a paintbrush, add dots of fabric paint around 
the heart and along the inside edges of the binding. Paint the 
background of the block if desired, using a stencil; let dry. 

A bamboo chopstick makes a 
great point turner to turn small 
projects right side out. You can 
also use it as a stiletto to hold 
fabrics in place for sewing.

Yvonne's Favorite Tool
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Bonus Project!
Confetti Heart on  
Painted Background
Supplies: 

Heart Pattern #2
6" square of watercolor paper
2-5 colors of paint and brush
decorative frame with 3"-4" opening

Use left over confetti-stitched fabric to cut out heart 
Pattern #2. Paint watercolor paper as desired using 
2-5 colors. Remove the paper backing from the heart 
and heat set for 10 seconds to secure to the center of 
the watercolor paper. Trim the watercolor paper to fit 
the frame opening and frame your art!

•
•
•
•
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Painted Grid Heart 
Supplies:
• Heart Pattern #3
• two layers of fabric and one piece of flannel,  
  12¾" x 14" each
• HRFive temporary spray adhesive
• fabric marker
• metallic fabric paint and pearl or gold to mix the colors
• stencil & brush
• beads as desired; hand-sewing needle and thread

Step One
Clear Foot #34/34C; Straight Stitch – Length 2mm 
Layer fabric right sides together. Place flannel on top of the 
fabric, using temporary spray adhesive to secure. Using a fabric 
marker, trace Heart Pattern #3 onto the flannel. Stitch on the 
drawn line, completely around the heart shape. Trim away 
flannel as close as possible outside of the stitching line. Trim 
the fabric to a scant ¼" from the stitching line. Clip the curves 
and cut off the bottom point without cutting into the stitch-
ing. Turn over and pull up one layer of fabric, make a small cut, 
then slit to about 2". Reach inside and pull to turn right sides 
out. Use a chopstick as a point turner to push out seams and 
use blunt end to smooth seam from inside; press. Slipstitch 
(with hand-sewing needle) the opening to close the seam. 
Topstitch around the edge of the heart, about ¼" to 3⁄8" from 
the edge. 

Step Two
Clear Foot #34/34C with Quilting Seam Guide; Straight 
Stitch – Length 2mm 
Attach the Quilting Seam Guide to the back of the presser foot 
and set the guide 1" from the needle. Stitch across the heart in 

1" grid. Start and end the grid at the topstitching; pull threads 
to back and tie off. Press. 

Step Three
Add paint to surface, using metallic paint and pearl or gold to 
mix the colors. Use the point of the brush to daub paint colors 
onto the heart shape. Allow to dry; add beads as desired.
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Layered Button Heart
Supplies: 

Heart Pattern #4
three pieces of wool or felt in different colors
HRFive temporary spray adhesive
18-23 assorted buttons.

Step One
Open Embroidery Foot #20/20C; Blanket 
Stitch – Length 2mm-4mm, Width 4mm-6mm
Cut out three hearts using Pattern #4, cutting 
layers #1, #2, and #3 in different colors. Stack the 
three hearts with the largest on the bottom and 
smallest on top, using spray adhesive to temporar-
ily hold them together. Using a Blanket Stitch, sew 
around the edge of the top heart, joining all three 
layers in the process; press. 

Step Two 
Button Sew-On Foot #18; Universal stitch or the Button 
Sew-On program; lower the feed dog
Cut out about 14 circles in assorted colors. Lower the presser foot 
and turn the handwheel by hand to be sure the needle pierces the 
holes without hitting the button; adjust stitch width if needed. Stitch 
on buttons in a planned or random pattern, alternating fabric circles 
under some of the buttons. Pull threads to the back to tie off.

•
•
•
•

Fiber Collage Heart
Supplies: 

Heart Pattern #5
two pieces 7" x 7" wool felt, assorted yarns and fibers 
such as Designer Threads by QRI
monofilament thread and lightweight bobbin thread
construction thread
two 6" pieces of narrow ribbon
small amount of polyester  
stuffing

•
•

•
•
•
•

Step One
Braiding Foot #21 OR Bulky Overlock Foot #12C;  
Zigzag stitch - Length and Width 3mm
Insert yarn or decorative fiber into the hole on top of the foot. Using 
monofilament needle thread and lightweight bobbin thread, stitch the 
yarns to one piece of the fabric, turning the wool to make interesting 
patterns. 

Step Two
Trace heart Pattern #5 on the second piece of wool; layer the two 
wool squares together and pin. Cut 2 pieces of narrow ribbon 6" 
long, make a loop, cross over ribbons and stitch together leaving 1" 
at bottom; find the center top and insert ribbon between the two 
layers, securing with a pin. 

Zipper Foot #4; Straight Stitch – far right needle  
position and then far left needle position

Change to construction thread in a color to match the wool. Move the 
needle position to far right and straight stitch, aligning the side of the 

foot with the drawn line. Tip: As you sew, keep them aligned and stop as 
needed, using the Free Hand System to slightly lift the foot to release the fabric, 

resulting in smooth curves. Move the needle position to far left and straight 
stitch a second time, again leaving an opening as indicated on the pattern. 

Stuff the heart shape using small amounts of stuffing and a chopstick as a 
tool. Stitch the opening closed and then complete the stitching of the outer 

line. Trim the wool away as close as possible to the outer stitching line.



Using the Heart Patterns
Locate the pattern number 
indicated in the instructions and 
using copy or tracing paper, 
trace the appropriate heart. 
Note: For half patterns, fold the 
copy or tracing paper and 
position the fold of the paper 
on the indicated line of the 
pattern. Trace the half 
pattern, then cut out the 
traced heart with the 
paper still folded; unfold 
and use pattern accord-
ing to the instructions.
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Needle punched designs on their own
are beautiful, but a little embellishing
makes them come alive! This attrac-

tive wool vest has “back interest” created by
a punched floral design, further embellished
with free-motion stitching and machine
beading.

CONSTRUCTION NOTES

The needle punched design is completed
before any construction takes place. The
vest is put together as instructed by the
pattern, using the serger for construction
and edge finishing. Note: The pattern does

not call for any lining; however, a lining for
the upper back area was created to cover

the wrong side of the needle punched
design.

NEEDLE PUNCHED DESIGN

Locate the upper back pattern piece. Cut a piece of
wool large enough to accommodate the pattern piece

but do not cut out the pattern piece. Draw around the
pattern on the wool fabric to let you see where the cutting

lines are for the upper back.

Attach the Needle Punch Accessory Set to the machine following the
directions included with the set. Note: Viewing the included DVD is recom-

mended before first using the Needle Punch Accessory Set.

Starting with the red circular flower, go through the
yarn and find pieces that are loosely spun running red
to green. Cut several similar pieces from the yarn.

Pull the yarn
pieces apart
and arrange in
a circular shape.
The center of
the flower is
achieved by

finding portions of the yarn that are spun tight.
Fluff open one end but leave the other end
tight, positioning it as the center of the flower

to create the desired
effect.

BY NINA MCVEIGH

NINA’S YARN TIP
“A great deal of needle 

punching success depends
on the wool (or other fibers)

that you find to use. I 
suggest you use hand dyed,
variegated yarns, which give

natural-look shading and
more interesting results,
making you look like an

artist. I like to let the yarn
help me decide the design.
The yarn shown is “Fun” by

Ironstone---color #108 - 
variegated in color and in
thickness, being wound 

tightly in some places and
more loosely in others.”
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Needle punch the yarn into the fabric. The area needs to be punched from the
right side, then from the wrong side and lastly, from the right side one more time.

The yarn also dictates the sunflower design. Looking through the skein, find
pieces that are brown to yellow. With this particular yarn the yellow turned into
green as it became tightly twisted. The tight twist is left in the yarn creating the
tip of the petal. As the petals go towards the center they are opened and nee-
dle punched. The color variation in the yarn is what gives the petal a natural
look. The other elements of the design are created the same way, letting the

yarn dictate what the design should be. Complete the design as desired.

When the design has been completely needled punched (from the right side, the wrong side and the right side
again) and you are pleased with the look, it is time to add embellishments. 

EXTRA EMBELLISHMENTS

Thread the machine with a decorative thread using an appropriate needle
and lightweight thread on the bobbin. If your machine has the BERNINA®

Stitch Regulator capability, set it up by attaching the BSR foot, lowering the
feed dog and adjusting the presser foot pressure to 0. If not, simply set up
your machine for free-motion sewing and attach your favorite free-motion
stitching presser foot.

Choose an area of design that will be improved with extra thread work, such
as the petals on the sunflower. Fill areas with thread to enhance the design.
You may want to experiment a little to see what you like---straight stitch or
zigzag BSR. The zigzag stitch will fill in faster and more solidly. Note: The
BSR Zigzag stitch option is only available with the artista models.

Machine beading will add even more depth to the needle punched design.
Insert a size 60 needle and thread the machine with monofilament thread.
Machine beading is a free-motion technique so leave the feed dogs lowered;
it requires no presser foot. Leave the lightweight bobbin thread in place. 

Place the area you want to bead, such
as the center of the sunflower, in the
spring hoop. Pour an assortment of
beads into the hoop. (The hoop keeps
your beads from rolling off your project!)
Pull up bobbin thread to the top of the
fabric, take a few anchoring stitches and
cut the thread ends. Using tweezers,
hold a bead with the hole facing up. Turn the hand wheel

until the tip of the needle is in the bead. If the bead is not exactly where you want, you can
actually drag it with the tip of the needle to the right spot. Move your fingers away from
the needle. Lower the needle into the bead, and then raise it. Tip: If your machine is
equipped with an electronic foot control, tap your heel on the back of the foot con-
trol, dropping the needle into the bead; using your heel again, raise the needle.
Move slightly away from the bead and take a stitch. The bead will flip over on its
side and lay the way it should. Travel by stitching to where you want the next
bead. Repeat the process until the beading is as desired, taking a few tiny
stitches to tie off the thread; clip thread ends.

VEST CONSTRUCTION

When finished embellishing the design, cut the upper back piece on the pattern
cutting lines. Cut out the rest of the vest. After stitching the princess seams and the
shoulder seams of the vest, lay a length of yarn along one seam. Punch it into the
wool, creating a stripe of varying thicknesses next to the seamline. Punch from both
sides as for the design. Repeat for the remaining princess seam. Assemble the remain-
der of the vest as the pattern instructs.

SUPPLIES
• Princess line vest pattern –

sample shown was made with Easy
Silhouette Vest by Indygo Junction

• 11/4 yards wool fabric (according to the pattern)
• Construction thread to match wool fabric

• 4 cones of serger thread to match wool fabric
• Decorative embroidery threads 

such as rayon, cotton, or silk
• Lightweight thread for bobbin

• Assorted yarns as desired
• Assorted beads as desired 

• Monofilament thread for beading
• Size 60 sewing machine needle for beading

• 5” spring embroidery hoop
• BERNINA® Stitch Regulator #42 (BSR) or 

other free-motion foot
• Needle Punch Accessory Set

• Tweezers 

BERNINA® STITCH
REGULATOR #42

Eliminate hours of practice!
Available for the current
aurora and artista

machines, this foot regulates
the stitch length of 

free-motion stitching so 
even if you have never tried 

it before, you will be 
successful at producing

even, consistent free-motion
stitches in a matter of minutes.
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The perfect size for

Grandma’s purse, this

little scrapbook photo

album unfolds to show

loads of photos of your

little angels!

COVER INSTRUCTIONS5

Using temporary spray adhesive, bond sta-
bilizer to the back of the cover fabric. Draw
two 8” squares on the cover fabric with a
fabric marking pen. Mark the center of
each square for embroidery placement.

Note: The design area is 6” square with an extra
1” allowed on all sides for finishing. Hoop, aligning one of the
center markings with the center of the hoop template.
Embroider the desired design and lettering for the front cover.
Re-hoop and stitch the desired design for the back cover on
the second marked square.

Cut out each 8” square. Center one of the squares on each
piece of mounting board. One inch is allowed on all edges to
turn to the back of the mounting board. Glue this 1” border in
place; allow it to dry with a heavy book or weight on top of it.

Note: For Page and Assembly Instructions, consult the diagram
and the photos of the finished pages on the following page.

BY ELVA MUNGAI

SUPPLIES

• Two 6” squares of self-stick padded mounting board
(typically for mounting and framing         needle-
work)

• 10” x 20” fabric for front and back covers (will be
embroidered and cut later)

• Six 12” x 12” squares of coordinating fabrics for
“pages”

• 2 yards of fusible web

• OESD PolyMesh Cut-Away stabilizer

• HRFIve temporary spray adhesive

• Desired embroidery designs: The designs shown on
the sample are from Studio BERNINA® True Friends
embroidery collection available from
www.embroideryonline.com 

• Isacord Embroidery thread in desired colors

• Lightweight bobbin thread

• Fabric marking pen

• Craft glue

• Photos, frames, and die cuts of your choice

• Black permanent marking pen or printed labels

• Assorted trims, ribbons, buttons and 3-D elements



PAGE INSTRUCTIONS

The six 12” fabric squares
will be used to make three
double-sided photo pages.
Determine which fabrics will
be fused back to back, but do
not fuse at this time.

Fold each of the six fabric
pages into quarters and fin-
ger press creases to divide
the square into 4 quarters;
turn each square 45°.
Embellish any or all of the
quarter sections as desired
using decorative frames,

embroidery, stitches, buttons, ribbons, and trims (see photos below). Note: Your photos are not
added at this time; they will be attached after the pages are fused together.

After the embellishing is complete, fuse two squares back to back using fusible web following the
manufacturer’s instructions. Repeat with the remaining squares for a total of 3 double-sided pages.

ASSEMBLY INSTRUCTIONS

Arrange the pages as shown in the diagram. Glue or fuse the overlapped sections as indicated in
the diagram. Glue or fuse the indicated areas to the inside of the front and back covers.

Add photos and desired 3-D elements to the “pages”. Fold on the creases as indicated in the dia-
gram to close the book.

LETTERING 
The BERNINA® Embroidery
systems have a variety of
Alphabet fonts available – from
5 choices on the aurora
machines to 10 with the artista
730E! Not only can you per-
sonalize your creations, but
you can also select the perfect
size lettering for your project.
BERNINA® embroidery sys-
tems offer completely scalable
alphabets – as you change the
size of the lettering to fit your
project, the stitch count is
automatically adjusted so the
density of the stitching is per-
fect, giving you the look you
want.

With the 730E, using WordArt
is also an option. This simply
means that you can choose
your favorite baseline for your
project – horizontal, vertical or
even curved – with a simple
touch of the screen!
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INSIDE

OUTSIDE
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Select the motif – Basket Extra –

#CC80906

Select All, then group the selected parts

together Tip: Creating a combination of

designs is easier if the parts of the motif are

grouped.

Select the Rotate 45 deg CCW /

CW icon and rotate the motif as

shown.

Scale motif if desired. In this particular recipe, motif

was scaled to approximately 30mm square.

Select File > Copy, then Select File > Paste; make as

many copies as desired in the hoop and begin stack-

ing the motifs vertically.

Select All. To quickly line up the motifs, use the align-

ment tools. Select Align Centers (Vertical) tool.

When pleased with the design, save the motif and send

to the embroidery machine of your choice, using the

Write to Machine icon.

Select fabric, stabilizer, and hoop. Embroider the motif. When

embroidery is complete, remove from the hoop. Trim additional

stabilizer away. Jill’s Tip: “Most embroidery motifs achieve the

nicest results with the use of Cut-Away stabilizer products.

However, when working with sewing machine stitches, Tear-Away

stabilizers are my personal preference for the reduction of bulk,

plus easy removal.” 

Add decorative stitches to frame the embroi-dered motif(s). Regardless of the model ofmachine being used, the stitch width for allof the stitches is 5.5mm. If working with a9mm stitch width, the length should beadjusted so that the stitch is proportional(see Stitch Chart). 

The recipe will be sewn from the center out,a format referred to as Stacked Stitches.Use the following charts to determine thestitches, settings, and stitching order to use.

Stitch recipes are not just for sewing machine stitches! Try combining
a beautiful embroidery motif with some of your favorite machine stitch-
es – the results can be stunning! This recipe starts with a motif select-
ed from Marie Osmond’s Expressive Lace collection – “Lace Up Your
Life” Vol. 1. Use it to embellish table linens, jacket fronts, decorator
pillows, and almost any type of sewing project.

By Jill Danklefsen

EMBROIDERY CENTER

STACKED BORDERS

Stitching Order

6  5  4    3    1  2        Center Embroidery      2  1    3    4  5  6
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Whether going to the beach or enjoying a day of shopping, you’re sure to
find these accessories a must for your wardrobe. They are “Sew Easy”
to make using commercial patterns and BERNINA® accessories and

techniques (see left). 

LIFE IS PRECIOUS TOTE BAG

Complete directions for this bag can be found on page
86 in the book, Bags and Accessories with Style by
Stephanie Kimura. The bag was made according to
these directions with the following addition.

Cut out the header and body pieces of the tote
bag front and the back. Sew the two pieces of the
tote bag front together; press the seams open.
Repeat this same process with the tote bag back
pieces. 

Decorative stitching will be applied to the seam.
Before stitching, apply a strip of Ultra Clean & Tear

stabilizer with HRFive temporary spray adhesive behind the seam.

Thread the machine with a decorative embroidery thread; Isacord embroidery
thread was used on the sample. Select a decorative stitch that is symmetrical
from side to side. Position the center guide of Edgestitch Foot #10/10C in the
center of the seam and sew the decorative stitch along the entire seam.

Select more of your favorite stitches and add two additional rows of decorative
stitching on the header fabric.

Cut out random shapes, such as a fan
pattern, or perhaps the flowers from the
hat fabric. Back these with Steam-a-Seam
2 and fuse to body of tote bag. Attach the
Open Embroidery Foot #20/20C to the
machine; use a size 80 needle and
Isacord thread that matches the appliqué
fabric. Appliqué the fused shapes to the

body of the tote bag using either decorative stitches and/or a satin stitch.

Place batting behind the appliquéd tote bag section, securing with temporary
spray adhesive if desired. Quilt the background around the appliqués, using the
BSR Foot #42. With the revolutionary BSR (BERNINA® Stitch Regulator) foot, free-
motion quilting can be mastered even by beginners. An optic sensor in the foot
interprets the fabric movement and adjusts the speed of the needle accordingly,
giving consistent and even stitches. If your machine doesn’t have BSR capability,
simply drop the feed dog and use your favorite free-motion presser foot.

BY FAITH REYNOLDS

All projects in this article started with a
commercial pattern or instructions from the
book, Bags With Style by Stephanie Kimura.
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On tissue paper, trace from the pat-
terns, “life is precious” and “dance as if
no one is watching”. Place the tissue
patterns on the headers of the tote bag
and pin in place. Thread the machine
with a contrasting color of Isacord
thread. Using the BSR Foot #42, follow
the traced pattern to free-motion stitch

the phrases on the headers. When stitching is complete, carefully tear away the
tissue paper.

Layer the handle pieces on batting and sew the side seams. Turn right side out
and quilt with a stipple stitch using the BSR foot. Finish the Tote Bag according to
instructions.

EYEGLASS CASE - Simplicity #5025

Cut out case, lining and front pocket. Cut a bias binding strip
of fabric 16”-20” long by the width of the opening on the
Bias Binder Attachment (see instructions included with the
binder). Cut the end of the strip to a point and feed it into
the binder. Tip: use a stiletto or seam ripper to push the strip
through the attach-
ment. Pull the bias
strip until it extends
about 11/2” past the
end of the binder;

sew a few stitches
along the edge of the folded bias,
adjusting the needle position to sew
near the edge. 

Using the Binder Attachment #84 with Foot #94, bind the upper edge of the front
pocket. Trim excess binding even with the pocket. Compatible with all models of
BERNINA® machines, the Binder attachment folds under the edges of a bias strip
and then folds it in half to wrap around the raw edge of a project. This complete
process happens before the fabric gets to the needle so that it is ready for stitch-
ing as it passes under the needle. Perfect binding will appear behind the foot;
sewn in place on both the front and back edges of the binding!

Layer the wrong side of pocket on the right side
of case. Stitch the upper edge to the lining and
press open.

Fold the case/lining in half lengthwise; stitch
around all edges, leaving an opening along the
lower edge of the lining. Turn the eyeglass
case/lining right side out. Using Edgestitch Foot
#10/10C, stitch the opening closed and fold
the lining into the case.

Move the needle to the far left. Position the
guide on Edgestitch Foot #10/10C next to the
upper edge of the case and stitch around the
upper edge of the case. When topstitching is
desired, Foot #10/10C is perfect for all weights

of fabrics. Its center guide helps position the fab-
ric close to the needle when stitching straight or curved edges.

SUMMER HAT - Vogue #7460

SUMMER HAT - Vogue #7460

Cut out and sew the crown
of the hat according to

pattern instructions.
Topstitch each side
of the seams on the

crown of the hat, with
the same color Isacord

thread that you are using for
construction of the hat. To topstitch, place the center
guide of Edgestitch Foot #10/10C in the center of the
seam, move the needle to the far left and stitch the
entire length of the seam. Repeat the process and stitch
a second row of stitches with the needle in the far right
position.

After stitching brim sections together, turn right side out.
Place the guide of Foot #10/10C along the outer edge of
the brim. Move the needle to the far left and edgestitch
around the hat brim. 

Attach Patchwork Foot #37 – nee-
dle in center position to continue
topstitching the brim of hat with
rows of stitches 1/4” apart. Align
the side of the foot with the
edgestitching and continue stitch-
ing circles until the entire brim has
been topstitched.

Stitch the brim and crown sections
together. To hide the raw edges on
the inside of hat, stitch grosgrain
ribbon to the inner edge as
described in the pattern directions.

Create a decorative band using the 18mm Clover Bias
Tape Maker. Following the directions included with the
Tape Maker, prepare and cut a bias strip of fabric 11/2” x
36”. As you pull the strip through the tape maker, press
it with the Bernette IS 60 Iron.

Sew the band to the hat using Edgestitch Foot #10/10C
Slip the hat onto the freearm of the machine and place
the guide of the foot next to the hatband. Adjust the
needle position to stitch along the edge of the band.
Repeat for the opposite side of the hatband.

The Bernette IS 60 is a professional quality iron, combin-
ing strong steam power with an evenly heated soleplate.
This combination of steam and temperature guarantee
quality ironing and pressing.
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SILK CANOPY AS A SASH OR HATBAND - Bags and Accessories with 
Style by Stephanie Kimura

Cutting instructions for this silk canopy are found on page
68; cut as directed.

Stitch beaded fringe to the short ends of the tie using
Leather Roller Foot #55. Place the right side of the
beaded fringe against the right side of the fabric –

raw edges even. Move the needle position two
spaces to the left and stitch closely to the bead-

ed fringe. Not only is this foot great for sewing
on beads, it also works well for sewing close

to large cording and for outline quilting
because it is easy to negotiate corners
and curves with the assistance of the
feed dog feeding the fabric.
Remember, there is only one point of
contact with the feed dogs - sort of like
doing freemotion sewing with a “train-
ing wheel”.

Place the right sides of fabric together and use the previous stitching as a guide
to sew the ends together.

Set up the serger for a 4-thread balanced stitch. Sew the side seams, leaving a
small opening for turning right side out. Finish by stitching the opening closed
with a hand-sewing needle and thread.

PERSONAL ORGANIZER CASE - Simplicity #5025

Embellish the front of the organizer with decorative stitches using
Clear Foot #34/34C and the Circular Embroidery Attachment
#83. Note: The Circular Embroidery Attachment works with most
presser feet, offering the possibility of sewing perfect circles for
a variety of techniques such as pintucking, piping, quilting, etc.

Attach the Circular Embroidery attachment to your machine.
Before placing your fabric on the pin of the attachment, layer
Ultra Clean and Tear stabilizer under the fabric. The pin is

adjustable on the attachment. Sliding the pin further away from
the sewing area will increase the size of the circle. Select your favorite decorative
stitch and watch it sew in a circle. Tips:
In most cases, placing the pin an
uneven number of notches from the
needle will cause the decorative stitch
to meet at the end of the pattern.
Select the Pattern End function when
approaching the completion of a circle.

Remove the Circular Embroidery Attachment and attach the Binder Attachment
along with Binder Foot #94. Prepare bias strips and use the same settings as
with the eyeglass case, finishing the edges of the inside pocket.

With Patchwork Foot #37, sew zipper-by-the-yard around the edges of the case.
Place right side of zipper tape against right side of fabric – edges together. Line
up the edge of Foot #37 with the raw edge of the fabric and zipper tape. Sew zip-
per by the yard around the edges of the case. You’ll get a perfect 1/4” seam while
creating some space between the zipper and the line of stitching at the same
time.

Reattach the Binder Attachment and finish the outer edges of the organizer case.

CITRUS CINCH BELT - Bags and 
Accessories with Style by Stephanie 
Kimura - Page 91

Cut belt and batting out of fab-
ric and attach snaps as direct-
ed by the instructions in the
book. Stitch seams and turn
right side out. To embellish
the belt, trace the stitching
pattern onto tissue paper.
Place drawn pattern on top
of finished belt. Thread the
machine with a contrast-
ing color of thread and
attach BSR Foot #42. (If
your particular machine
model does not have
the BERNINA® Stitch

Regulator function, select a
free-motion presser foot of your choice.) This
patented innovation registers the movement
of the fabric and regulates the length of your
stitches, making free motion stitching easy.
Lower the feed dog. Select straight stitch
and shorten the stitch length to approximate-
ly 1.5mm as the design is rather small.
Stitch, following the traced pattern. When the
stitching is complete, gently tear the tissue
paper away.

For complete information on the 
BERNINA® presser feet and accessories
discussed in this article, see Feetures,
Volumes 1, 2, 
and 3, available
at your local
BERNINA® dealer.



The projects shown here started
with these commercial patterns:
McCall’s 3387, 
McCall’s 6907, 
Kwik Sew 
2379, and 
McCall’s 
M4432.
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It’s “Sew Easy” and so fun to create for kids! Make these great items for the children in
your life using BERNINA® presser feet and quick techniques. Don’t let the projects fool
you, they are fast, fun and easy to make! They all start with commercial patterns, fol-

lowing the directions and adding a few BERNINA® techniques to speed things up and make
the finished projects look great!

FUZZY FLEECE JACKET – McCall’s 3387

Stitch the hood of this cute jacket with a lapped seam that is finished on both the inside
and outside. The Lap Seam Foot #71 makes it simple and fast! Using a double needle for
topstitching adds a professional look to the finish of the jacket.

Hood
• Pin hood pieces together, offsetting the seam

allowance about 3/8” - 1/2”. 

• Attach Lap Seam Foot #71 to the machine and
insert a size 80 Ballpoint needle.

• Sew the first seam using a Straight stitch with a
length of 3mm; allow the offset edge to fold into
the foot, encasing the raw edge of the fleece.

• Insert fabric into foot with finished edge up.

• Sew the second seam so that the raw edges are
both encased and lying flat.

Double Needle Topstitching
• Change to Walking Foot #50. Sew pocket to garment

with a single needle using a stitch length of 4mm
and sewing from the wrong side.

• Insert a 4.0 Stretch Double Needle to the machine and thread with two threads. 

• From the right side, sew the pocket to the
garment using the previous stitching as a
guide.

• On the wrong side, trim the excess seam
allowance next to stitching.

• Construct the rest of the jacket with serged
seams using a basic 4-thread overlock stitch.

• Use a double needle and Walking Foot #50
to topstitch the entire garment including the sleeve and body hems. To pivot with the
double needle, stop with the needles up and use the handwheel to bring the needle
points to barely touch the surface of the fabric. Carefully pivot the fabric 90° and raise
the needles to straighten them. Sew a stitch. Note: Tap your heel on the foot control if
this feature is available. The stitches are perfect using the Walking Foot and the fabric
doesn’t shift due to the fact that the bottom of the walking foot aligns with the feed dog
of the machine, moving both layers of fabric simultaneously through the machine.

T H R O U G H  T H E  N E E D L E



• Select a
Zigzag stitch
with SW-
2.0mm and
SL- 2.0mm

• Attach
Overlock
Foot #2 to
machine
and over-
cast the front facing edges. 

Exquisite Embroidery 
• From OESD Design Pack #11945 - Embellishments 5,

open Design NA140 in the Editor Lite software. (NOTE:
Design Pack available from www.embroideryonline.com)

• Send to machine. 

• Back the area to be embroidered
with OESD Aqua Film stabilizer. 

• Hoop and embroider the design
twice, positioning them at the
center of the lower edge of the
bodice as shown in the photo.

• Unhoop the fabric and remove the stabilizer by rinsing
and/or soaking as needed.

Gathering Made Easy 
• Fold small cord in half, thread folded end into guides in

Cording Foot #22.

• Select the
Gathering stitch
and sew along
the seam line.

• Remove the
project from the
machine and pull
on cord to gather. 

• Complete the garment according to the pattern
instructions.

MONOGRAMMED BACKPACK – 
Kwik Sew 2379, view A

Backpacks are useful for all age groups, young or old,
boy or girl. Add your own special touches to this one to
suit anyone you choose.

Front Flaps
• For each flap (upper and pocket) plan to cut one flap

from a quilted, print fabric and one from a contrasting
fabric. Tip: Start with larger pieces of fabric and cut the
flaps out after the monogram and quilting is complete.

• Embroider the desired monogram on one of the con-
trasting fabric pieces for the upper flap.

• Cover the back of the quilted fabric with the mono-
grammed fabric; outline quilt around the monogram. 

• Use a design shape from the quilted fabric to quilt the
two fabrics together. The contrasting fabric will be the
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AUTOGRAPH BEAR – McCall’s 6907

Make this “signature” bear with your own unique fabric, created from simple
muslin and the wonderful decorative stitches found on your machine! Add beauti-
ful embroidered lettering, customized with Editor Lite software to label the bear.

The Body of The Bear
• With a fabric marker, draw lines 4” apart on muslin. Back the muslin with

OESD Tear-away stabilizer. 
• Attach Clear Foot #34/34C to the machine
• Using Isacord machine embroidery thread and a size 75 embroidery needle,

sew decorative stitches on the lines using desired thread color and stitches. 
• Cut two layers of muslin for body (otherwise the fabric is too thin). Hold the lay-

ers together with temporary spray
adhesive. 
• Change to a size 80 needle with

a sharp point; attach Patchwork
Foot with Guide #57 to the
machine.

• Sew the body pieces together
according to the pattern.

• Sew buttons at designated
places for eyes using Button
Sew-On Foot #18.

Embroidered Lettering Your Way! 
• Open the BERNINA® Editor Lite software. Note: Other levels of the BERNINA®

embroidery software can also be used.
• Left click on the lettering tool. 
• Click on desktop; type Autographs. 
• Select lettering; right click to open Object Properties Box. 
• Select the Upper Curved Baseline; click OK to return to desktop. 
• Right click on selected lettering and change the lettering size in General tab

to 3.9”, approximately 100mm. Click OK. 
• Select Write to Machine. 
• Embroider the lettering, centering the word on the bear’s front chest.
• Assemble and stuff the remainder of the bear according to the pattern

instructions.

PRETTY PARTY DRESS – McCall’s M4432, view F

A special occasion dress made of linen and embellished with heirloom stitching
and exquisite embroidery will take a young girl to almost any event.

Heirloom Stitching 
Preparation: To accommodate tucks in garment, add 3” to sleeve length. Add 4”
to skirt length. Use a ruler to mark lines 4” from bottom of skirt, 11/2” above that
and the third 11/2” above that. Repeat for second skirt piece. Use ruler to mark a
line 2” above the sleeve hem. Mark a second line 11/2” above the first and a
third line 11/2” above the second. Repeat for second sleeve. The marks are fold
lines and stitches are placed above them (towards shoulders/waistline). 

• Before adding the Heirloom stitching, serge skirt together at both sides.

• Attach Clear Foot #34/34C and insert a size 75 embroidery needle. Thread
with Isacord embroidery thread in the desired color. 

• Back the area to be stitched with OESD Lightweight Tear-away stabilizer.

• Program two stitches similar to those shown into the memory of the machine.  

• Sew one row of stitches above each marked line (toward shoulders/
waistline); the guideline should be just under the edge of the foot. 

• Fold a tuck into the garment, wrong sides together, stitching on the right side.
Sew, aligning the fold at the 1/2” marking on the stitch plate.



outside. Use Isacord embroidery thread in the needle and the bobbin so the
stitching looks pretty from both sides.

• Quilt the remaining piece of quilted fabric and contrasting fabric for the pocket
flap. 

• Trim to pattern size, removing seam allowances from pockets and flaps. 

• Attach Walking Foot #50 and overcast all raw edges using a Zigzag stitch - SL
3mm, SW 2.5mm and adjusting the needle position to stitch on the edge.

Beautiful Binding 
• Attach Binder

Attachment #84 with
Foot #94 to machine. 

• Prepare bias fabric
strips for binding accord-
ing to the attachment
directions.

• Insert the strip into the attachment and
bind the edges of the pocket and flaps
(pocket and upper). 

• To finish the bound edge, cut binding fab-
ric 1/8” past the metal end of the attach-
ment. Dab glue stick on the cut end of
binding fabric and fold the binding over
onto itself. Finish stitching. Tip: The dis-
tance from the needle to the end of the
attachment is 31/2”. Plan to have only
about 1/4” – 3/8” overlap.  

• Bind the side edges of backpack.

• Bind the bottom to the body of the backpack. 

• Bind the top edge of the backpack.

• Remove the binder attachment and use Edgestitch Foot #10/10C to sew the
pockets and the flaps onto the body of the backpack. 

Stylish Grommets
• Attach the Eyelet Embroidery Set #82 with Foot #92 to the machine per

instructions included with the set.

• Measure and mark eyelet placement according to the pattern instructions

• Using the appropriate punch included with the set, make holes in the backpack
at the marked places.

• Select a Zigzag stitch. Note: For a more interesting or creative look, consider
using a decorative stitch to create the eyelet. 

• Drop the feed dog of the machine.

• Place a punched opening onto the attachment and stitch, turn-
ing the fabric to overcast the edge of the opening. Repeat until
all eyelets are stitched.

Easy Attachments
• Remove the Eyelet Embroidery set and attach Piping Foot #38

• Sew Hook and Loop tape using Piping Foot #38.

• Remove Piping Foot #38 and Attach Edgestitch Foot #10/10C

• Attach webbing with Edgestitch Foot #10/10C.
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Foot #38

Foot #10/10C

For complete information on the 
BERNINA® presser feet and accessories
discussed in this article, see Feetures,
Volumes 1, 2, 
and 3, available
at your local
BERNINA® dealer.
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